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ABSTRACTS
The Students Industrial Work Experience Scheme (SIWES) is an accepted skills acquisition programme which forms part of the approved academic standard in the degree programme for Nigeria University. In 1974, the federal government of Nigeria introduced the national policy on industrial training, called the Students Industrial Work Experience Scheme (SIWES).This programmes is under the umbrella of the ministry of education through the industrial training fund (ITF), was designed to help students acquire the necessary practical education/experience in their field of study and other related professions. This is an effort which was created on order to bridge the existing gap between the theory taught in the classroom and practice of science, agriculture, medicine, engineering, technology and other professional programmes in the Nigeria tertiary institution. The programme was established basically to impact elaborate practical understanding to students with respect to their various disciplines. This report is a summary of the experience I acquired during my Students' Industrial Work Experience Scheme (SIWES)
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CHAPTER ONE
1.1 INTRODUCTION TO SIWES
Students Industrial Work Experience Scheme (SIWES) is a Skills Training Program designed to prepare and expose Students of Universities, Polytechnics, Colleges of Technology, Colleges of Agriculture and Colleges of Education for the Industrial Work situation they are likely to meet after graduation. The Scheme affords Students the opportunity of familiarizing and exposing themselves handling equipment and machinery that are usually not available in their institutions.
1.2 HISTORY OF SIWES
The Students’ Industrial Work Experience Scheme (SIWES) was initiated in 1973 by the Federal Government of Nigeria under the Industrial Training Fund (ITF) to bridge the gap between theory and practice among products of our tertiary Institutions. It was designed to provide practical training that will expose and prepare students of Universities, Polytechnics, and Colleges of Education for work situation they are likely to meet after graduation.
Before the establishment of the scheme, there was a growing concern among the industrialists that graduates of institutions of higher learning lacked adequate practical background studies preparatory for employment in industries. Thus the employers were of the opinion that the theoretical education going on in higher institutions was not responsive to the needs of the employers of labour.
As a result of the increasing number of students’ enrolment in higher institutions of learning, the administration of this function of funding the scheme became enormous, hence ITF withdrew from the scheme in 1978 and was taken over by the Federal Government and handed to National Universities commission (NUC), National Board for Technical Education (NBTE) and National Commission for Colleges of Education (NCCE). In 1984, the Federal Government reverted back to ITF which took over the scheme officially in 1985 with funding provided by the Federal Government.
1.3 OBJECTIVES OF THE PROGRAMME
The specific objectives of SIWES are to:
· Provide placements in industries for students of higher institutions of learning approved by relevant regulatory authorities (NUC, NBTE, NCCE) to acquire work experience and skills relevant to their course of study
· Prepare students for real work situation they will meet after graduation.
· Expose students to work methods and techniques in the handling of equipment and machinery that may not be available in schools.
· Make transition from school to the labour market smooth and enhance students’ conduct for later job placement
· Provide students with the opportunity to apply their knowledge in real life work situation thereby bridging the gap between theory and practice
· Strengthen employer involvement in the entire educational process and prepare students for employment in industry
Promote the desired technological knowhow required for the advancement of the nation.
1.4	OBJECTIVES OF ESTABLISHMENT
To provide innovative and effective solutions
· To deliver exceptional customer service
· To drive business growth and expansion
· To build a strong brand reputation
· To develop and maintain a skilled workforce
· To promote a culture of innovation and continuous improvement
· To maintain high-quality standards and best practices
· To foster strategic partnerships and collaborations



















CHAPTER TWO
2.1 ORGANIZATIONAL STRUCTURE
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2.2   HOW TO SET GOALS FOR INTERNSHIP
To set goals for an internship, you can consider your reasons for the internship, use the SMART framework, and ask for feedback. 

Consider your reasons 
· Think about what you want to get out of the internship
· Do you want to gain experience in a specific field?
· Do you want to improve a particular skill?
· Do you want to build professional connections?
· Do you want to learn more about the industry?

Use the SMART framework 
· Set goals that are Specific, Measurable, Achievable, Relevant, and Time-bound
· This will help you create clear goals that will help you grow throughout the internship.

Ask for feedback 
· Regularly ask your supervisor, mentors, or colleagues for feedback on your progress and performance
· Ask for specific areas of improvement and how you can better achieve your goals.

Track your progress 
· Check in on your status regularly
· For example, you could check on your progress towards yearly goals every quarter
Network Attend company events, Be active during team meetings, and Connect with colleagues on professional networking platforms. 

Build relationships 
· Networking can help you learn about job opportunities, solve problems, and advance your career.

2.3   POLICY ANALYSIS AND DEVELOPMENT
Policy analysis and development" refers to the systematic process of examining a problem, identifying potential solutions through research and evaluation, and then crafting a policy strategy to address the issue, including its implementation and ongoing monitoring to ensure effectiveness; essentially, it's the practice of researching, designing, and refining policies to achieve specific goals within a given context, like government or organizational level. 
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Key aspects of policy analysis and development
· Problem definition:
Clearly identifying the issue or concern that needs to be addressed by a policy. 
· Data collection and analysis:
Gathering relevant information through research, surveys, statistics, and other methods to understand the problem's scope and potential impacts. 
· Policy option identification:
Brainstorming and evaluating various potential policy solutions to address the identified problem. 
· Criteria development:
Establishing clear standards to assess the effectiveness of different policy options, such as cost-benefit analysis, social impact, and feasibility. 
· Policy evaluation:
Assessing the potential impacts of each policy option, including positive and negative effects on different stakeholders. 
· Policy formulation:
Drafting the final policy document, including clear objectives, implementation strategies, and monitoring mechanisms. 
· Policy implementation:
Putting the policy into action, which may involve allocating resources, training staff, and coordinating with relevant agencies. 
· Policy monitoring and evaluation:
Regularly reviewing the policy's effectiveness and making adjustments as needed based on feedback and data analysis. 

2.4 IMPORTANCE OF STAKEHOLDER ENGAGEMENT IN POLICY MAKING
Stakeholder engagement in policy making is crucial because it allows for a more comprehensive understanding of the issue at hand, fosters greater buy-in and support for the policy, increases legitimacy, identifies potential problems early on, and ensures that the policy addresses the needs of those most affected by it, ultimately leading to more effective and sustainable policy implementation. 
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Benefits of stakeholder engagement in policy making
· Accurate problem identification:
By involving diverse stakeholders, policymakers can gain a deeper understanding of the complexities of an issue and identify the root causes, rather than relying on assumptions. 
· Increased legitimacy and trust:
When stakeholders feel heard and involved in the policy process, they are more likely to trust the government and support the resulting policies. 
· Greater policy effectiveness:
Considering diverse perspectives during policy development leads to policies that are more tailored to the needs of the affected population, increasing the chances of successful implementation. 
· Early identification of potential challenges:
Engaging stakeholders early in the process can help identify potential obstacles and unintended consequences, allowing for adjustments to the policy design. 
· Enhanced ownership and commitment:
When stakeholders feel like they have a stake in the policy, they are more likely to actively participate in its implementation and advocate for its success. 
· Knowledge sharing and co-creation:
Stakeholder engagement facilitates the exchange of expertise and insights, leading to more informed policy decisions. 

Important aspects of stakeholder engagement
· Identifying relevant stakeholders:
Clearly defining who is affected by the policy and should be involved in the process. 
· Meaningful participation:
Ensuring that stakeholders have opportunities to provide input and feedback throughout the policy development process. 
· Transparency and communication:
Clearly communicating the policy goals, decision-making process, and rationale to all stakeholders. 
· Addressing power imbalances:
Taking steps to ensure that all stakeholders have an equal voice in the process, particularly marginalized groups. 






CHAPTER THREE
3.1	HOW TO DEVELOP SKILL IN DATA ANALYSIS AND REPORT WRITING
Developing skills in data analysis and report writing can be achieved through a combination of learning, practice, and experience. 
· STEPS TO HELP YOU DEVELOP THESE SKILLS
DATA ANALYSIS
1. Learn statistics and data analysis concepts: Understand descriptive and inferential statistics, data visualization, and data mining techniques.
2. Familiarize yourself with data analysis tools: Learn to use tools like Excel, SQL, Tableau, Power BI, Python, or R.
3. Practice with sample datasets: Use public datasets or sample data to practice data analysis and visualization.
4. Join online communities and forums: Participate in online communities, such as Kaggle, Reddit (r/dataanalysis), or Stack Overflow, to learn from others and get feedback on your work.
5. Take online courses or certifications: Consider taking courses or certifications, such as Coursera, edX, or Data Science Council of America (DASCA), to improve your data analysis skills.




REPORT WRITING
1. Learn to structure reports effectively: Understand how to organize reports, including executive summaries, introductions, methodologies, results, and conclusions.
2. Develop your writing skills: Improve your writing skills by reading books, articles, and reports, and by practicing writing.
3. Practice writing reports: Write reports on sample data or case studies to practice your report writing skills.
4. Get feedback from others: Share your reports with others and ask for feedback to improve your writing and reporting skills.
5. Learn to visualize data effectively: Understand how to create effective data visualizations, such as charts, graphs, and tables, to support your reports.
COMBINING DATA ANALYSIS AND REPORT WRITING
1. Practice integrating data analysis and report writing: Practice analyzing data and writing reports on the findings.
2. Use real-world examples: Use real-world examples or case studies to practice integrating data analysis and report writing.
3. Join projects or competitions: Participate in projects or competitions, such as data science competitions or hackathons, to practice integrating data analysis and report writing.
4. Read and learn from others: Read reports and articles written by others, and learn from their approaches and techniques.
5. Continuously improve your skills: Continuously update your skills and knowledge in data analysis and report writing to stay competitive.
3.2 HOW TO CONDUCT RESEARCH ON COMMUNITY DEVELOPMENT INITIATIVES
STEPS ON HOW TO CONDUCT RESEARCH
· Define your research question and objectives:
Clearly state what you want to learn about the community development initiative, including its impact, effectiveness, and potential challenges. 
· Understand the community context:
Conduct a thorough analysis of the local demographics, social issues, existing community organizations, and relevant policies to inform your research. 
· Identify key stakeholders:
Engage with community leaders, residents, service providers, government officials, and other relevant parties to understand their perspectives and priorities. 
· Conduct a community needs assessment:
Use surveys, focus groups, or participatory observation to gather data on the community's needs, strengths, and gaps in services. 
· Review existing literature:
Analyze previous research on similar community development initiatives to inform your approach and identify potential gaps in knowledge. 
· Choose appropriate research methods:
Depending on your research question, consider using quantitative methods like surveys, qualitative methods like interviews and focus groups, or mixed methods combining both approaches. 
DATA COLLECTION AND ANALYSIS
· Gather data: Administer surveys, conduct interviews, observe community events, and collect relevant documents. 
· Analyze data: Use appropriate statistical techniques to identify patterns, trends, and relationships within the data. 
COMMUNITY ENGAGEMENT
· Participatory research: Involve community members in the research process, such as co-designing research questions, collecting data, and interpreting results. 
· Disseminate findings: Share research results with the community in accessible formats to inform future decision-making and program development. 
Evaluation of community development initiatives:
· Establish clear indicators: Define measurable indicators to assess the impact of the initiative on key community issues. 
· Monitor and evaluate: Regularly collect data to track progress and assess the effectiveness of the initiative. 
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3.3   HOW TO FILL DOCUMENT (PERSONAL AND POLICY FILES)
Filling documents on personal and policy files requires attention to detail, accuracy, and completeness. 
Step-by-step guide
Personal Files
1. Gather required documents: Collect all necessary documents, such as identification, address proof, and qualifications.
2. Fill personal details: Accurately fill in personal details, including name, date of birth, address, and contact information.
3. Update employment and education history: Ensure employment and education history is up-to-date and accurate.
4. Declare health and medical information: Disclose any relevant health or medical information, if required.
5. Sign and date the documents: Sign and date the documents, as required.
Policy Files
1. Read and understand policy terms: Carefully read and understand the policy terms, conditions, and exclusions.
2. Fill policy details: Accurately fill in policy details, including policy number, coverage, and premium.
3. Provide required documentation: Attach required documents, such as proof of ownership or identification.
4. Disclose relevant information: Disclose any relevant information, such as pre-existing conditions or claims history.
5. Sign and date the documents: Sign and date the documents, as required.
General Tips
1. Use black ink: Use black ink to fill documents, as it is easier to read and scan.
2. Print clearly: Print clearly and legibly, avoiding errors or illegible writing.
3. Use correct dates: Use correct dates, including the current date and any relevant policy or renewal dates.
4. Attach required documents: Attach required documents, such as identification or proof of ownership.
5. Review and verify: Review and verify the documents for accuracy and completeness before submitting.
Digital Documentation
1. Use digital signature tools: Use digital signature tools, such as DocuSign or Adobe Sign, to sign documents electronically.
2. Scan and upload documents: Scan and upload documents, as required, to digital platforms or online portals.
3. Use secure online platforms: Use secure online platforms, such as encrypted websites or secure email, to transmit sensitive information.
4. Verify digital documentation: Verify digital documentation, such as digital signatures or uploaded documents, for authenticity and accuracy.

MAILING (RECEIVING AND DISPATCHING OF MAILS)
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Steps involved in receiving and dispatching mail
Receiving Incoming Mail:
· Collection: Gathering mail from the mailroom or delivery service.
· Date stamping: Marking the date of receipt on each piece of mail.
· Sorting: Categorizing mail based on recipient, department, or priority level.
· Opening (if necessary): Carefully opening sealed envelopes that require immediate attention.
· Distribution: Delivering mail to the designated recipient or department. 
Dispatching Outgoing Mail:
· Preparation: Ensuring all necessary information is complete on the envelope, including recipient address, sender details, and any required postage. 
· Addressing: Accurately writing out the recipient's address. 
· Sealing: Properly sealing envelopes to protect the contents. 
· Sorting: Grouping mail based on destination for efficient delivery. 
· Postage application: Affixing the correct postage stamps or meter marking. 
· Submission: Delivering the mail to the postal service or designated courier. 

 











CHAPTER FOUR
4.1 KEEPING AND ARRANGING OF FILES
	Keeping and arranging of files" refers to the practice of systematically storing and organizing documents, both physical and digital, in a structured manner using folders, consistent naming conventions, and logical categorization to ensure quick and easy access to information when needed; essentially, good file management. 
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Key aspects of keeping and arranging files
· Folder organization:
Grouping related documents into dedicated folders based on topic, project, or client to separate different categories of information. 
· File naming conventions:
Using a consistent naming system for files, including dates, project codes, or descriptive titles, to easily identify their content at a glance. 
· Subfolders:
Creating further divisions within folders to further categorize documents and improve retrieval speed. 
· Chronological order:
Arranging files based on date, especially useful for tracking progress or following timelines. 
· Alphabetical order:
Organizing files alphabetically by title or key identifier for efficient searching. 

· Version control:
Tracking changes made to a document by maintaining different versions of the same file 
· Regular purging:
Regularly reviewing and deleting outdated or unnecessary files to maintain a clean and organized system. 

4.2 HOW TO INPUT DATA INTO A COMPUTER (STAFF INFO)

To input staff information into a computer, you typically open the dedicated staff database or spreadsheet program, navigate to the relevant fields for each employee, and type in their details like name, contact information, job title, department, and any other required information using the keyboard; you can also use a mouse to select options within the program depending on its design. 

Steps to take
· Access the system:
Log in to the staff management software or open the designated spreadsheet where you want to store staff data. 
· Create new entries:
· Click on "Add New Employee" or a similar option to start a new record. 
· Select the appropriate fields (e.g., "First Name", "Last Name", "Email Address", "Job Title"). 
Enter data:
· Type the relevant information into each field using the keyboard. 
· Double-check for accuracy, especially when entering sensitive details like social security numbers. 
Save the entry:
· Press "Enter" or click "Save" to finalize the data entry. 
Important considerations:
· Data format consistency:
Ensure you follow the specified format for entering data (e.g., dates, phone numbers). 
· Data validation:
Some systems may have built-in checks to verify data accuracy (e.g., checking if an email address is in the correct format). 
· Data source:
If you are transferring data from paper forms, carefully transcribe information to avoid errors. 
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4.3   HOW TO USE MICROSOFT WORD
To use Microsoft Word, you can create a new document, open an existing document, and add and format text. You can also add images, shapes, charts, and more. 
Create a new document 
1. Select the File tab
1. Select New
1. Select Blank document or double-click a template image
Open an existing document 
1. Look in the left column for a list of your most recently used documents
Add and format text 
1. Click on your new blank page
1. Select text to format
1. Choose font options on the Home tab
Add images, shapes, charts, and more 
1. Select the Insert tab
1. Select what you want to add
Save and share documents
You can save and share documents using Word. 
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CHAPTER FIVE
5.1 	CONCLUSION
The Student Industrial Work Experience Scheme (SIWES) plays a significant role in human resource development, it helps students develop new skills and enlightens them of what the present society holds for them after graduation and helps them adapt accordingly.
5.2    RECOMMENDATIONS 
I put forward the following recommendations for future improvement of the scheme;
· Organizing workshops, seminars and symposium for students in various faculties in other to keep the student abreast of new technologies and innovations.
· Posting of students for SIWES should be done by the scheme to ensure conformity with course of study.
· A mass enlightenment campaign should be carried out, to enable industries and establishments to know the importance of SIWES to the future of the student and the society at large. 
· The scheme should also try to enforce the act guiding the establishment of the scheme, to serve as a deterrent to those establishments who reject student for IT.
· School Curriculum should be organized in such a way that the SIWES exercise be carried out at a stretch of six months and not the intermittent arrangement of three months twice.  
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